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Foreword

Please read this chapter carefully before using this product!

This chapter introduces the safety precautions before using this product. Please
make sure the content of this chapter is fully read and understood before installation
and usage. Our company will ot undertake any responsibilities for any damage or
injury caused by improper operations because of ignoring relevant warning in this
operation instruction.

Before operating this device, relevant professional personnel shall read this
instruction carefully and well understand the content.

Operation instructions and warnings:

The following standard definitions will be adopted in this operation instruction.

Danger! Ignoring of safety precautions may cause personal death, serious personal
injury or serious equipment damage.

Warning! Ignoring of safety precautions may cause personal death, serious
personal injury or serious equipment damage.

Caution! Ignoring of safety precautions may cause a slight personal injury or
equipment damage, especially the damage of device or the equipment protected by
the device.

 Danger!

When the primary system is live working, secondary open circuit for the current
transformer connected to the device is absolutely forbidden, and the open of this
circuit may cause extremely dangerous high voltage.

 Warning!

Some parts of the device may have high voltage when the electrical device is running.
Improper operation may cause serious personal injury or equipment damage.

Only qualified professional personnel are allowed to operate the device or work
nearby the device. The operators professional shall well understand the precautions,
working flows and safety regulations mentioned in this instruction.

 Caution!
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Grounding terminals of the device shall be firmly grounded.

The device is only permitted to run in atmospheric environment that specified in the
technical specifications, and abnormal vibrations shall be avoided in its running
environment.

When connect the AC voltage current circuit or power circuit, please make sure they
conform to the rated parameters of the device.

When the output terminals of the device are connected to external circuit, please
check carefully the voltage of external power to prevent overheating of the circuit.

Carefully check the cable connected to the device, preventing applying too much
external force on it.

 Note!

Every care has been taken in preparation of this manual. However, please note that
not all the details or variations in the equipment or process being described can be
covered. Neither is it expected to address all contingencies associated with the
installation and operation of this equipment. If you need more information, please
contact the manufacturer.

The fixed value in the picture is only for demonstration, not for actual configuration.



3

Contents

CHAPTER 1: OVERVIEW ........................................................................................5

1.1 Description ..............................................................................................................5

1.2 Protection ................................................................................................................5

1.4 Supervision ............................................................................................................. 5

1.5 Control .................................................................................................................... 5

1.6 Features .................................................................................................................. 6

1.7 Monitoring Functions ............................................................................................6

1.8 Hardware ................................................................................................................7

1.9 Data Storage and Communication .......................................................................7

CHAPTER 2: TECHNICAL PERFORMANCE INDEX ........................................ 8

2.1 Inputs and Outputs ................................................................................................8

2.2 Unit Design ........................................................................................................... 10

2.3 Serial Interface .....................................................................................................10

2.4 Data Storage ......................................................................................................... 10

2.5 Mechanical Tests ..................................................................................................10

2.6 Electrical Tests ..................................................................................................... 11

2.7 Climatic Tests .......................................................................................................13

CHAPTER 3: PROTECTION FUNCTIONALITY .............................................. 14

3.1 Function Description ........................................................................................... 14

3.2 Inverse time current protection ..........................................................................22

3.3 Constant Value Parameters ................................................................................ 43

3.4 Data Storage ......................................................................................................... 47

CHAPTER 4: USER INTERFACE ......................................................................... 48

4.1 Status and Trip Target LEDs ............................................................................. 49

4.2 Pushbuttons ..........................................................................................................49

4.3 Operator Controls ............................................................................................... 50



4

4.4 Default Display .....................................................................................................52

4.5 The Main Menu ....................................................................................................52

4.6 Submenu ............................................................................................................... 53

4.7 Entering the password interface .........................................................................55

4.8 Relay setting ......................................................................................................... 56

4.9 Save parameter .................................................................................................... 65

4.10 Parameter set ..................................................................................................... 65

4.11 Communication ..................................................................................................67

4.12 Calibration ..........................................................................................................69

4.13 Clear ....................................................................................................................69

4.14 Auto switch group ..............................................................................................69

4.15 View relay and setting ....................................................................................... 69

4.16 View report .........................................................................................................70

4.17 View input signal ............................................................................................... 70

CHAPTER 5: PERIPHERAL ACCESSORIES .................................................... 71

5.1 RF remote controller ........................................................................................... 71

5.2 Features and the use of external sockets and switches .....................................71

5.3 The main secondary component parts ...............................................................72

5.4 Capacitor (Used by permanent recloser) ...........................................................72

5.5 Battery .................................................................................................................. 72

CHAPTER 6: INSTALLATION AND MAINTENANCE .................................... 73

6.1 Installation ............................................................................................................73

6.2 Maintenance ......................................................................................................... 73

6.3 Parts Attached with the Device .......................................................................... 73

CHAPTER 7: DECOMMISSION AND DISPOSAL ...........................................74

7.1 Decommission .......................................................................................................74

7.2 Disposal .................................................................................................................74



5

Chapter 1: Overview

1.1 Description

RWK-381 line sectionalizing load break switch controller is a kind of switch which
must cooperat with superior switch. It can’t cut off the fault current, it only trip when
the line is low-voltage or no-current.

RWK-381 line sectionalizing load break switch controller adopts IT operation mode.

When a fault happed, the controller will record the fault times. If the times come to
the setting value, the controller will trip after the line is low-voltage or no-current.

The controlling box is made of stainless steel, the surface is dealt with painting,
anticorrosion, can be used in outdoor environments.

It has charging circuit: It could take AC220V charging power supply from outside. If
there is no power supply outside, it also could achieve opening/closing operation and
all controller functions with battery. Besides that, it is set with anti-over discharge
circuit for protecting the battery when there is no electricity of the power supply
outside for a long time.

1.2 Protection

Section function (Section)

50 Instantaneous/Definite-Time Overcurrent (P.OC)

51 Phase Time-Overcurrent (P.OC2/P.OC3)

Over Load (Overload)

50N Residual Ground Instantaneous/Definite-Time Overcurrent (G.OC)

51N Residual Ground Time-Overcurrent (G.OC2/G.OC3)

50SEF Sensitive Earth Fault (SEF)

51c Cold Load (Cold load)

TRSOTF Switch-Onto-Fault (SOTF)

59 Over Voltage（L.Over volt）

27 Under Voltage (L.Under volt)

1.4 Supervision

74T/CCS Trip & Close Circuit Supervision

60VTS VT Supervision

1.5 Control

86 Lockout

CB Control
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1.6 Features

Password Protection – 2 levels.

50Hz/60Hz systems and two phase/three phase wiring method are available, so that
the use scope of device is extended.

Protection configuration is complete, and all protection functions can be switched on
and off flexibly.

9-way intellectual switching value input.

Large capacity flash memory can record at least 100 times of historical events, and
no data will loss even the power is off.

Circuits operating loop can be used both the direct or alternating current, self-
adaptation open/close brake function, which can co-work with various of breakers,
and the operation is simple and reliable.

The device has complete self-inspection function to in-service monitor the working
conditions of various parts of the device, ensuring the reliability of the device.

1.7 Monitoring Functions

Primary/Secondary Phases and Earth Currents

Direction

Primary/Secondary Line and Phase Voltages

Apparent Power and Power Factor

Real and Reactive Power

Positive Phase Sequence Voltage

Negative Phase Sequence Voltage & Current

Zero Phase Sequence Voltage

Earth Current With 3RD Harmonics

Frequency

Binary Input/Output status

Trip circuit healthy/failure

Time and date

Event records

Counters

Wear
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1.8 Hardware

4 CT

7 VT

1 Battery

9 Binary Inputs

4 Binary Outputs

1.9 Data Storage and Communication

RS485/USB or RS485/RS232 port and Ethernet/RJ45

Protocols –IEC60870-5-101, IEC60870-5-104, DNP3.0 or Modbus RTU

Event Records

Fault Records

Measurands

Commands

Time Synchronism

Viewing and Changing Settings
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Chapter 2: Technical Performance Index

2.1 Inputs and Outputs

Phase Current Inputs

Quantity 3

Rated Current In 5A

Measuring Range 20 x In

Instrumentation≥ 0.1xIn ±1% In

Frequency 50/60Hz

Thermal Withstand:

Continuous

10 Second

1 Second

2 x In

10 x In

40 x In

Burden @ In ≤0.2VA (5A Phase element)

Sensitive Earth Current Inputs

Quantity 1

Rated Current In 5A

Measuring Range 2 x In

Instrumentation≥ 0.1xIn ±1% In

Frequency 50/60Hz

Thermal Withstand:

Continuous

10 Second

1 Second

2 x In

10 x In

40 x In

Burden @ In ≤0.02VA (1A Earth element)
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Voltage Inputs

Quantity 1 PT voltage

Nominal 40…120 Vrms

Operating Range 0...200 Vrms

Instrumentation≥0.8xVn ±1% Vn

Burden @ 110V 0.06 VA

Overvoltage Withstand 240 Vrms

Voltage sensor Inputs

Quantity 6 x Voltage sensor

Nominal 0…60 Vrms

Auxiliary Supply

DC Voltage 220V

Range 110 to 265V

AC Voltage 220 V AC 50/60Hz

Range 165 to 265Vrms AC

50/60Hz ±5%

Power consumption ≤100W/300W

Binary Inputs

Number 9

Operating Voltage 24V DC

Maximum dc current for operation 2mA
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Binary Outputs

Number 2

Operating Voltage 220V DC

Operating Mode User selectable - Self or Hand/Electrical
Reset or pulsed

Operating Time from Energizing Binary
Input

<20ms

2.2 Unit Design

Indication 16 Character 4 line Display 10 LED’s

User Interface 12 Navigation Keys

Weight 32kg

2.3 Serial Interface

Communication Port RS485 or USB

Protocols IEC60870-5-101

IEC60870-5-104

DNP3.0

MODBUS RTU

2.4 Data Storage

Events 100 times

2.5 Mechanical Tests

Vibration (Sinusoidal) --- IEC 60255-21-1 Class I

Type Level Variation

Vibration response 0.5gn ≤5%

Vibration withstand 1.0gn ≤5%
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Shock and Bump --- IEC 60255-21-2 Class I

Type Level Variation

Shock response 0.5gn, 11ms ≤5%

Shock withstand 15gn, 11ms ≤5%

Bump test 10gn,16ms ≤5%

Shock and Bump --- IEC 60255-21- 3 Class I

Type Level Variation

Seismic response

X-plane-3.5mm

Displacement

below crossover

freq (8-9Hz) 1gn

and above

Y-plane-1.5mm

Displacement

below crossover

freq (8-9Hz)

0.5gn above

≤5%

Mechanical Classification

Durability >106 operations

2.6 Electrical Tests

Insulation --- IEC 60255-5

Type Level

Between any terminal and earth 2.0 kV AC RMS for 1 min

Between independent circuits 2.0 kV AC RMS for 1 min

Across normally open contacts kV AC RMS for 1 min
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High Frequency Disturbance --- IEC 60255-22-1 Class Ⅲ

Type Level Variation

Common (longitudinal) mode 2.5 kV ≤5%

Series (transverse) mode 1.0 kV ≤5%

High Frequency Disturbance --- IEC 60255-22-2 Class Ⅳ

Type Level Variation

Contact discharge 8.0 kV ≤5%

Fast Transients --- IEC 60255-22-4 Class A (2002)

Type Level Variation

5/50 ns 2.5 kHz repetitive 4 KV ≤5%

Surge Immunity --- IEC 60255-22-5

Type Level Variation

Analog Inputs:

Line to Earth

4.0 kV ≤10%

Case, Aux Power & I/O: Line to Earth 2.0 kV ≤10%

RS485 Comms port: Line to Earth 1.0 kV No Data Loss

Analog Inputs:

Line to Line

1.0 kV ≤10%

Case, Aux Power & I/O: Line to Line 1.0 kV* ≤10%

* Note 45ms DTL pick-up delay applied to binary inputs

Conducted Radio Frequency Interference --- IEC 60255-22-6

Type Level Variation

0.15 to 80 MHz 10 V ≤5%
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Radiated Radio Frequency --- IEC 60255-25

Type Limits at 10 m, Quasi-peak

30 to 230 MHz 40 dB(µV)

230 to 10000 MHz 47 dB(µV)

Conducted Radio Frequency

Type Limits

Quasi-peak Average

0.15 to 0.5 MHZ 79 dB(µV) 66 dB(µV)

0.5 to 30 MHZ 73 dB(µV) 60 dB(µV)

Radiated Immunity --- IEC 60255-22-3 Class Ⅲ

Type Level

80 MHz to 1000 MHz Sweep 10 V/m

1.4GHz to 2.7GHz Sweep 10 V/m

80,160,380,450,900,1850,2150 MHz Spot 10 V/m

2.7 Climatic Tests

Temperature --- IEC 60068-2-1/2

Operating Range -10°C to +55°

Storage range -25°C to +70°

Humidity --- IEC 60068-2-78

Operational test 56 days at 40°C and 93%

relative humidity
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Chapter 3: Protection Functionality

3.1 Function Description

Section function

The section function must cooperat with superior switch. It can’t cut off
the fault current, it only trip when the line is low-voltage or no-current.

When a failure occurs on the line，the current exceed the protection value which
you set, superior switch cut off the fault, the section controller will record the fault
and counter add one (it will be reset after a while if it have no subsequent failures).
When the counter is more than the time you set, the section controller will trip. So
that the fault zone can be cut off from the line.

Action Logic diagram：

Note: Run is “√”，Stop is “×”.

IA IB IC—Measured current Iset—Pickup current T1—The time after count
Cset—Count times which you set

50 Instantaneous/Definite-Time Overcurrent (P.OC)

The controller adopts phase current through high precision 3 phase current sensor
inside main body. The overcurrent faults could be judged according to phase
current,if the current is greater than the set value , the controller will trip.

P.OC2/P.OC3 offer the time-overcurrent curve function.

Note: If the section function is run , the protection do not work.

Action Logic diagram：

Note: Run is “√”，Stop is “×”.

IA IB IC—Measured current Iset—Pickup current T—Delay time
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Overload (Overload)

When the load of line is bigger than the rate value ，overload protection will trip the
circuit breaker

Note: Run is “√”，Stop is “×”.

IA IB IC—Measured current Iset—Pickup current T—Delay time

50N Residual Ground Instantaneous/Definite_Time Overcurrent (G.OC)

The residual ground overcurrent elements are derived from phase current input
channels IA, IB and IC. The residual Ground mode derives the earth current
internally from the 3 phase CT inputs to give earth fault.

G.OC2/G.OC3 offer the time-overcurrent curve function.

Note: If the section function is run , the protection do not work.

Action Logic diagram：

Note: Run is “√”，Stop is “×”.

3IG—Earth current (3IN) 3IGset—Pickup current T—Delay time

Action Logic diagram with direction：

Note: Run is “√”，Stop is “×”.

3IG—Earth current (3IN) 3IGset—Pickup current T—Delay time
3IG∠3U0—Angle of 3IN exceeding 3U0
Set start angle and end angle is in “Common value”menu
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51SEF Sensitive earth fault (SEF)

The neutral ground over current element is derived from phase current input channel
3IN. Current channel 3IN is internally wired residually with phase current input
channels IA, IB and IC, so the residual ground an neutral ground overcurrent
elements see the same magnitude zero-sequence current.

Neutral Ground mode directly measures the earth current from an independent CT,
this input can be ordered as sensitive earth fault.

Note: If the section function is run , the protection do not work.

Action Logic diagram：

Note: Run is “√”，Stop is “×”.

3IN—Sensitive earth current 3INset—Pickup current T—Delay time

Action Logic diagram with direction：

Note: Run is “√”，Stop is “×”.

3IG—Sensitive earth current (3IN) 3IGset—Pickup current T—Delay time
3IG∠3U0—Angle of 3I0 exceeding 3U0
Set start angle and end angle is in “Common value”menu

The reference phase and phase range should be set when the protection is run in
mode 1 (Direction mode). The reference phase and phase range must be set for
judging ground faults on loading side and power supply side when it is installed in
the middle of line.

The setting value means phase angle of zero sequence current when the phase
angle of zero voltage is 0°. Normal setting method for different ground system as
follows：

 Neutral ungrounded or small resistance ground system setting=270° ± 85°. In
neutral ungrounded or small resistance ground system, the phase angle of zero
sequence current and zero sequence voltage is close to 270° when ground fault
happens on loading side. The phase angle of zero sequence current is close to
70°when ground fault happens on power supply side. So it’s easy to distinguish
ground fault on loading side or power supply side. According to above
judgement basis, the most suitable phase setting range is 270°±85°in neutral
ungrounded or small resistance ground system. The setting range could be
regulated according to actual operation environment and condition.
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 Arc-suppression coil ground system setting=180° ± 85°.
In arc-suppression coil (NES) ground system, the range of phase angle for over
compensation is ＞90°～＜180° when the faults happen on loading side,
however it is installed in the outlet terminal, or in the middle of line or in the end
of line of substations, the range of phase angle for under compensation is ＞

180° ～＜270°. The range of phase angle is ＞0°～＜90° when the faults happen
on power supply side. The most suitable phase angle setting range is 180°±85°.
And also, the phase angle could be regulated according to actual operation
environment and condition.

51c Cold Load Pickup (Cold load)

If a circuit breaker is closed onto a “cold” load, i.e.one that has not been powered
for a prolonged period, this can impose a higher than normal load-current demand
on the system which could exceed normal settings. These conditions can exist for an
extended period and must not be interpreted as a fault. To allow optimum setting
levels to be applied for normal operation, the cold load pickup feature will apply
alternative current settings for a limited period. The feature resets when either the
circuit breaker has been closed for a settable period, or if the current has reduced
beneath a set level for a user set period.

When the time of the line lost current longer than the “Loss-load time”, the load of
the line be cold. Next time the line have current, ”Cold load” protection start, the
protection you set (phase fault/earth fault)is invalid, the recloser just trip when the
current satisfy the logic diagram below .After the ” Restore time”, ”Cold load”
protection end the protection you set is available.
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Action Logic diagram：

Note: Run is “√”，Stop is “×”.

IA IB IC—Measure current 3I0—Measure Ground current (3IN)
Iset—Pickup-Phase current IGset—Pickup-Ground current

TRSOTF Switch-Onto-Fault (SOTF)

When switching on manual closing acceleration, if accidents happened in the exit
time after operated the close, the phase over current protection will accelerate the
operation. The exit time of acceleration can be adjusted.
Action Logic diagram：

Note: Run is “√”，Stop is “×”.

IA IB IC—Measured current Iset—Pickup current T—Delay time
T1— The time after manual close

59 Over Voltage (L.Over volt)

The device take the line voltage as the criterion for over voltage protection.

Action Logic diagram：

Note: Run is “√”，Stop is “×”.

UAB UBC UCA—Measured line voltage Uset—Pickup voltage T—Delay time
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27 Under Voltage (L.Under volt)
The device take the line voltage as the criterion for under voltage protection. Under
voltage protection include mode I (No voltage +Low voltage protection), mode II
(Via current locking low voltage protection) and mode III (Pure low-voltage
protection).

Action Logic diagram：

Mode 1：No voltage +Low voltage protection

Note: Run is “√”，Stop is “×”.

UAB UBC UCA—Measured line voltage Uset—Pickup voltage T—Delay time

U1—positive sequence voltage U2—negative sequence voltage

Mode2： Via current locking low voltage protection

Note: Run is “√”，Stop is “×”.

UAB UBC UCA—Measured line voltage Uset—Pickup voltage T—Delay time

IA IB IC—Measured current
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Mode3：Pure low-voltage protection

Note: Run is “√”，Stop is “×”.

UAB UBC UCA—Measured line voltage Uset—Pickup voltage T—Delay time
U1—positive sequence voltage

81 Frequency Protection (Frequency)

When the frequency of the power PT is to high or to low, the Recloser will tirp to
protect the line.

Action Logic diagram：

Note: Run is “√”，Stop is “×”.

F—Frequency F/S—The rate of frequency (HZ) and seconds (S)
UAB UBC UCA—Measured line voltage Uset—Pickup voltage T—Delay time

Direct.Power

When the total three-phase power exceeds the set power, it will act after a delay
time. This protection has directional options. When set to forward, if the active
power exceeds the setting power value and is positive, it will trip; When set to
reverse, if the active power exceeds the setting power value and is negative, it will
trip.

Action Logic diagram：

Note: Run is “√”，Stop is “×”.

Total P—Three phase active power Pset—Pickup power T—Delay time
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Control circuit breaking alarm

In normal situation, the switch on and switch off signals are in different status, and
when these two signals are in the same status for 10s, the device will send control
circuit breaking alarming signal.

Hotline

When the line is in the repair, you can turn on the feature of hotline, and we can not
make any closing operation for safety. Press the “Hotline” pushbutton the feature of
hotline is turned on. Press the “Hotline” pushbutton again, the feature of hotline is
turned off.
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3.2 Inverse time current protection

The following information describes the curve timing for the curve and time dial
settings made for the time-overcurrent elements. The time-overcurrent relay curves
conform to IEEE C37.112-1996 IEEE Standard Inverse-Time Characteristic Equations
for Overcurrent Relays.

Tp = Operating time in seconds
TD = Time-dial setting
M = Applied multiples of pickup current

Equations Associated With IEC Curves
No Curve Type Operating time

1 C1 (Standard Inverse) 










）（ 1M
14.0TDT 02.0p

2 C2 (Very Inverse) 










）（ 1M
5.13TDTp

3 C3（Extremely Inverse） 










）（ 1M
80TDT 2p

4 C4（Long-Time Inverse） 










）（ 1M
120TDTp

5 C5（Short-Time Inverse） 










）（ 1M
05.0TDT 04.0p

Equations Associated With U.S.Curves

No Curve Type Operating time

6 U1 (Moderately Inverse) 










）（ 1M
0104.00226.0TDT 02.0p

7 U2 (Inverse) 










）（ 1M
95.5180.0TDT 2p

8 U3（Very Inverse） 










）（ 1M
88.30963.0TDT 2p

9 U4（Extremely Inverse） 










）（ 1M
67.50352.0TDT 2p

10 U5（Short-Time Inverse） 










）（ 1M
00342.000262.0TDT 02.0p
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IEC Class A Curve (Standard Inverse): C1
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IEC Class B Curve (Very Inverse): C2
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IEC Class C Curve (Extremely Inverse): C3
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IEC Long-Time Inverse Curve: C4
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IEC Short-Time Inverse Curve: C5
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U.S. Moderately Inverse Curve: U1
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U.S. Inverse Curve: U2
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U.S. Very Inverse Curve: U3
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U.S. Extremely Inverse Curve: U4
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U.S. Short-Time Inverse Curve: U5
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Recloser Control Response Curves A, C, N, and W
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Recloser Control Response Curves B, R, 2, and 3
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Recloser Control Response Curves D, 8PLUS, and 16
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Recloser Control Response Curves F, H, J, and 1
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Recloser Control Response Curves G, V, 6, and 13
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Recloser Control Response Curves E, P, and 18
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Recloser Control Response Curves KG, Y, Z, and 5
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Recloser Control Response Curves KP, M, T, and 17



41

Recloser Control Response Curves 4, 9, 11, and 14
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Recloser Control Response Curves L, 7, 8, and 15
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3.3 Constant Value Parameters

All values are given primary side.

Section
Description Setting range Step length

Section
Pickup current 1～6000A 1A
Count 1～3 1
Lock Reset time 1～180S 0.1S

50/51 Phase Fault (P.OC/P.Fast curve/P.Delay curve)
Description Setting range Step length

P.OC1
Pickup current 1～6000A 1A
Delay time 0～9.99S 0.01S

P.OC2

Curve type

0: NONE 1: IEC-SI 2: IEC-VI
3: IEC-EI 4: IEC-LTI 5: IEC-STI
6: U.S-MI 7: U.S-I 8: U.S-VI
9: U.S-EI 10: U.S-STI 11: PB-80
12: PTB-1 13: USER-1 14: USER-2
13: USER-3 14: USER-4

Pickup current 1～6000A 1A
Time dial 0～99.99 0.01
Time adder 0～99.99S 0.01S
Minimum response 0～99.99S 0.01S

P.OC3

Curve type

0: NONE 1: IEC-SI 2: IEC-VI
3: IEC-EI 4: IEC-LTI 5: IEC-STI
6: U.S-MI 7: U.S-I 8: U.S-VI
9: U.S-EI 10: U.S-STI 11: PB-80
12: PTB-1 13: USER-1 14: USER-2
13: USER-3 14: USER-4

Pickup current 1～6000A 1A
Time dial 0～99.99 0.01
Time adder 0～99.99S 0.01S
Minimum response 0～99.99S 0.01S

Overload (Overload)
Description Setting range Step length

Overload
Pickup current 1～6000A 1A
Delay time 0～99.99S 0.01S
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50G/51G /Sensitive Earth Fault (G.OC/SEF)
Description Setting range Step length

G.OC1
Direction mode 0: Disable

1: Enable
Pickup current 1～6000A 1A
Delay time 0～9.99S 0.01S

G.OC2

Direction mode 0: Disable
1: Enable

Curve type

0: NONE 1: IEC-SI 2: IEC-VI
3: IEC-EI 4: IEC-LTI 5: IEC-STI
6: U.S-MI 7: U.S-I 8: U.S-VI
9: U.S-EI 10: U.S-STI 11: PB-80
12: PTB-1 13: USER-1 14: USER-2
13: USER-3 14: USER-4

Pickup current 1～6000A 1A
Time dial 0～99.99 0.01
Time adder 0～99.99S 0.01S
Minimum response 0～99.99S 0.01S

G.OC3

Direction mode 0: Disable
1: Enable

Curve type

0: NONE 1: IEC-SI 2: IEC-VI
3: IEC-EI 4: IEC-LTI 5: IEC-STI
6: U.S-MI 7: U.S-I 8: U.S-VI
9: U.S-EI 10: U.S-STI 11: PB-80
12: PTB-1 13: USER-1 14: USER-2
13: USER-3 14: USER-4

Pickup current 1～6000A 1A
Time dial 0～99.99 0.01
Time adder 0～99.99S 0.01S
Minimum response 0～99.99S 0.01S

SEF
Direction mode 0: Disable

1: Enable
Pickup current 1～80A 1A
Delay time 0～9.99S 0.01S

51c Cold Load Pickup (Cold load)
Description Setting range Step length

Cold load

Pickup-Phase 1～6000A 1A
Pickup-Ground 1～6000A 1A
Loss-load time 0.1～99.99S 0.01S
Restore time 0.1～99.99S 0.01S
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TRSOTF Switch-Onto-Fault (SOTF)
Description Setting range Step length

SOTF

Exit time 0.1～9.99S 0.01S
Pickup current 1～6000A 1A
Delay time 0～9.99S 0.01S

59 Over Voltage (L.Over volt)
Description Setting range Step length

L.Over volt

Operating mode 0: Disable 1: Trip 2: Alarm

Pickup voltage 1~42KV 0.1KV

Delay time 0～99.99S 0.01S

L.Over volt2

Operating mode 0: Disable 1: Trip 2: Alarm

Pickup voltage 1~42KV 0.1KV

Delay time 0～99.99S 0.01S

27 Under Voltage (L.Under volt)
Description Setting range Step length

L.Under volt
Operating mode

0: Invalid
1: No voltage +Low voltage protection
2: Via current locking low voltage protection
3: Pure low-voltage protection

Pickup voltage 1~42KV 0.1KV
Delay time 0～99.99S 0.01S

L.Under volt2
Operating mode

0: Invalid
1: No voltage +Low voltage protection
2: Via current locking low voltage protection
3: Pure low-voltage protection

Pickup voltage 1~42KV 0.1KV
Delay time 0～99.99S 0.01S

81 Frequency Protection (Frequency)
Description Setting range Step length

Frequency

Low frequency 40～60Hz 0.1Hz
High frequency 50～65Hz 0.1Hz
Delay time 0.1～20S 0.01S
Slip lock 0: Disable

1: Enable
Slip value 0.3～40 0.1
Low volt. lock 0: Disable

1: Enable
Low volt. value 1～42KV 0.1KV
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Direct.Power
Description Setting range Step length

Direct.Power

Operating mode 1: Trip
2: Alarm

Pickup power 1～60000KW 1KW
Delay time 0～60000S 1S

Direction mode
1-None
2-Forward
3-Reverse

Common value
Description Setting range Step length

Common value

I Start angle 0～360 1

I End angle 0～360 1
I0 Start angle 0～360 1
I0 End angle 0～360 1
PT offline 0～2 1
Under Volt. 1~42KV 0.1KV
U2 lockout 1~42KV 0.1KV

Lockout current 1～6000A 1A
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3.4 Data Storage

Data records are backed up in non-volatile memory and are permanently stored even
in the event of loss of auxiliary supply voltage. Data storage includes functions of trip
count, wear and event records. These records can be reset clear.

Counters

Total Trip Count (ALL): Increments on each trip command issued.
Phase Overcurrent Trip Count (OC): Increments on phase overcurrent trip command
issued.
Earth Fault Trip Count (EF): Increments on earth fault trip command issued.
Sensitive Earth Fault Trip Count (SEF): Increments on sensitive earth fault trip
command issued.
Section Trip Count (SEC): Increments on section trip command issued.
Phase Overvoltage Trip Count (OV): Increments on phase overvoltage trip command
issued.
Phase Under Voltage Trip Count (UV): Increments on phase under voltage trip
command issued.
Voltage Unbalance Trip Count (VU): Increments on voltage unbalance trip command
issued.
Electric Trip Count (Elec.): Increments on electric trip command issued.
Manual Trip Count (Manu.): Increments on manual trip command issued.
Remote Trip Count (Remote): Increments on remote trip command issued.
Other Trip Count (Oth): Increments on other trip command issued.

Wear

An I2t counter is also included and this can provide an estimation of contact wear
and maintenance requirements. The algorithm works on a per phase basis,
measuring the arcing current during faults. The I2t value at the time of trip is added
to the previously stored value. The t value is the time between circuit breaker
contacts separation when an arc is formed. Mechanical wear is the total number of
trips divided by CO Limit.

Event Records

Event records include tripping records, alarm records and SOE records. The event
recorder feature allows the time tagging of any change of state (Event) in the relay.
As an event occurs, the actual event condition is logged as a record along with a
time and date stamp to a resolution of 1ms. There is capacity for a maximum of
6400 event records (3000 trip records, 400 alarm records and 3000 SOE records)
that can be stored in the relay and when the event buffer is full any new record will
over-write the oldest. The following events are logged:
• Change of state of Binary outputs
• Change of state of Binary inputs
• Protection element operation



48

Chapter 4: User Interface

The operator interface is designed to provide a user friendly method of controlling,
viewing menus, entering settings and retrieving data from the relay. Eight buttons
are provided for navigation around the menu structure.
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4.1 Status and Trip Target LEDs

Most of the status and Trip Target LEDs and Operator Controls can change function
(if desired by the user) by programming at a higher logic level. This subsection
discusses each function as shipped from the factory and inscribed on the front panel.

4.2 Pushbuttons

Button Function

Illuminate all front-panel LEDs for 1 second.

Clear trip-latched targets TRIP, FAST CURVE, HIGH CURRENT,
81, A, B, C, G, and SEF.

Select displayed option or setting.

Cancel command edit or escape to upper command level.

Scroll up on display.
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Scroll down on display.

Scroll left on display.

Scroll right on display.

increment value.

decrement value.

4.3 Operator Controls

All the following operator control pushbuttons should be pressed momentarily to
execute their function.

Press the PROTECTION ENABLED to enable/disable
the protection tripping. Corresponding LED illuminates
to indicate the enabled state.

Press the OVR ENABLED to enable/disable the over-
voltage element tripping. Corresponding LED illuminates
to indicate the enabled state.

Press the UVR ENABLED to enable/disable the under-
voltage element tripping. Corresponding LED illuminates
to indicate the enabled state.

Press the GROUND ENABLED to enable/disable the
ground over-current and sensitive earth fault (SEF)
element tripping. Corresponding LED illuminates to
indicate the enabled state.
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Press the REMOTE ENABLED to enable/disable remote
control. Corresponding LED illuminates to indicate the
enabled state.

Press the HOTLINE ENABLED to enable/disable
hotline. Corresponding LED illuminates to indicate the
enabled state. NOTE:
When the reclose is in a status of hotline, the
CONTROLLER CLOSE pushbutton is invalid.

（Enter password to ON/OFF Lock button）
Press the LOCK operator control pushbutton to
enable/disable the lock function. Corresponding LED
illuminates to indicate the reclose is locked.While the
lock function is engaged,the following operator controls
are”locked in position”:

PROTECTION ENABLED HOTLINE
OVR ENABLED BATTERY TEST
UVR ENABLED CONTROLLER CLOSE
GROUND ENABLED CONTROLLER OPEN
REMOTE ENABLED

While “locked in position,” these operator controls
cannot change state if pressed—their corresponding
LEDs remain in the same state. When the lock function
is engaged, the CLOSE operator control can not close
the break, but the TRIP operator control can still trip
the break.
（Enter password to ON/OFF Lock button）

Press the CLOSE operator control pushbutton to show
the voltage of battery about 10s.

Press the CLOSE operator control pushbutton to close
the controller. Corresponding CONTROLLER CLOSED
LED illuminates to indicate the breaker is closed. The
CLOSE operator control pushbutton does not have to be
continually pressed to allow for cold load pickup (i.e.,
disable fast curves, and desensitize delay curves and
SEF element). There is automatic allowance for cold
load pickup. See the Cold Load Pickup settings in
Chapter 3.1: Function Description.

Press the Open operator control pushbutton to trip the
breaker (and take the control to the lockout state).
Corresponding CONTROLLER OPEN LED illuminates to
indicate the reclose is Open.
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4.4 Default Display

The LCD default display shows IA, IB, IC, 3IN, Upt, UA, UB, UC, UR, US, UT, UAB.
Note: The light of the LCD will turn off after five minutes, if you do not operator the
reclosing.

4.5 The Main Menu

Press “Enter” when on the main screen, as shown below, including “EDIT” and
“VIEW” menu item. Select the corresponding menu item with the [←] key, [→] and
press "ENTER" button to enter the corresponding sub-menu, press the “ESC” key to
return to the previous screen.

Primacy Menu
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4.6 Submenu

Edit submenu

Choose the edit options, the screen will enter the submenu of the Edit menu, as
shown below, the submenu includes “Relay”、“Para”、”Port”、“Chnl”、“Clr”、
“Time”、 “Fac”.

Submenu of edit

Enter “Relay” submenu, you can select the
corresponding group to enter and view each
protection feature and set up the parameters.

Enter “Para” submenu, you can modify or view
other parameters. Like CT rate, PT rate, PTS rate,
Operator password, CO limit, Wear Limit-MA^2s,
Wear Clearance, Telesignal time, Close pulse time,
Trip pulse time.

Enter “Port” submenu, you can modify or view
communication parameters.

Enter “Chnl” submenu, current and voltage values ​
​can be corrected, press the function key "ENTER"
to be modified.
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Enter “Clr” submenu, you can clear out the events,
counters, wear.

Enter the “Time” submenu will modify or check the
time.

Automatic switchover can be set in the group, which
can be switched to summer workday group,
summer rest day group, winter workday group and
winter rest day group. You can also set the start
and end time of summer and the start and end time
of rest days.

Enter “Fac.” Sub-menu, modify and view the factory
settings.

View submenu

Choose the view options, the screen will enter the submenu of the View menu, as
shown below, the sub-menu includes “Pmete”, “Smete”, “RPT”, “Relay”, “Para”,
“Input”, “Ver”.

View submenu

Enter “PMete” submenu, you can view the primary side
measurement data include: phase current, Ground current,
PT voltage, phase voltage, line voltage, active power,
reactive power, power factor, frequency, battery voltage,
earth current with 3RD harmonics.

Enter “SMete” submenu, you can view the secondary side of
the measured data include: phase current, Ground current,
PT voltage, phase voltage, line voltage, negative-sequence
current, negative sequence voltage, positive sequence
voltage, zero-sequence voltage.
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Enter “RPT” submenu, you can view the trip report, alarm
report, signal report, counters, wear.

Enter “Relay” submenu, you can select the corresponding
group to enter and view each protection feature is invested
and set up the parameters.

Enter “Para” submenu, you can view his argument. Like CT
rate, PT rate, PTS rate, Operator password, CO limit, Wear
Limit-MA^2s, Wear Clearance, Telesignal time, Close pulse
time, Trip pulse time.

Enter the “Input” submenu, you can view the input signal.
The input signal includes: Breaker open, Breaker close,
Remote open, Remote close, Low pressure, Manual lock,
Door, Active battery, Power fault, Spring ready, 2st backup
input.

Enter “Ver” submenu, you can view the device type,
version, date of manufacture and device ID.

4.7 Entering the password interface

According to the above operation, before entering each item will first enter a
password input interface to prevent professional staff misuse. The device original
password is “0099”, as shown below, press [←] and [→] keys to switch, press the
[+] and [-] keys to increase and decrease the number of line with the correct
password press “Enter” button to enter.

Password interface
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4.8 Relay setting

Select the “Relay” in the Edit submenu item, press the function key “Enter” to enter
the password screen, enter the correct password to enter the “Relay” submenu, as
Shown below, each item has a checkbox and set values.

1、Section: Section function
2、P.OC1: Instantaneous overcurrent
3、P.OC2: Time-Overcurrent fast Curves
4、P.OC3: Time-Overcurrent delay Curves
5、Overload: Overload function
6、G.OC1: Instantaneous Ground overcurrent
7、G.OC2: Gound Time-Overcurrent fast Curves
8、G.OC3: Ground Time-Overcurrent delay Curves
9、SEF: Sensitive earth fault protection
10、Cold load: Cold Load pickup
11、SOTF: Switch-Onto-Fault protection
12、L.Over volt: Over Voltage protection, 1st

13、L.Over volt2: Over Voltage protection, 2nd

14、L.Under volt: Under Voltage protection, 1st

15、L.Under volt2: Under Voltage protection, 2nd

16、Frequency: Frequency protection
17、Direct.Power: Direct power protection
18、Common value: PT supervision and some common values

Section (section)

Select section in relay menu press “Enter” key to enter, operational processes as
shown below:

Step 1: Setting the section protection current value, the
current value can be between 1A ~ 6000A.

Step 2: Setting the section protection count times, the
value can be between 1~ 3.

Step 3: Setting the reset time, the time can be between
1.2S ~ 180S.

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of section function setting
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Phase overcurrent（P.OC1）

Select P.OC1 in relay menu, press “Enter” key to enter, operational processes as
shown below:

Step 1: Setting the overcurrent protection current value,
the current value can be between 1A ~ 6000A.

Step 2: Setting the overcurrent delay time, the delay time
can be between 0S ~ 9.99S.

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of simple overcurrent protection setting

Phase fault fast curve protection（P.OC2）

Select P.OC2 in relay menu, press “Enter” key to enter, operational processes as
shown below:

Step 1: Choose the Curve type of Inverse-time overcurrent
or definite time overcurrent (NONE).

Step 2: Setting the overcurrent protection current value,
the current value can be between 1A ~ 6000A.

Step 3: Setting the Time dial of time-overcurrent curve.

Step 4: Setting the Time adder of time-overcurrent curve
(the delay time to trip after “Tp”).

Step 5: Setting the Minimum response of time-overcurrent
curve (If the “Tp” less than it, the recloser will trip after
this time).

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of phase fast curve protection setting
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Phase fault delay curve protection（P.OC3）
Select P.OC3 in relay menu, press “Enter” key to enter, operational processes as
shown below:

Step 1: Choose the Curve type of Inverse-time overcurrent
or definite time overcurrent (NONE).

Step 2: Setting the overcurrent protection current value,
the current value can be between 1A ~ 6000A.

Step 3: Setting the Time dial of time-overcurrent curve.

Step 4: Setting the Time adder of time-overcurrent curve
(the delay time to trip after “Tp”).

Step 5: Setting the Minimum response of time-overcurrent
curve (If the “Tp” less than it, the recloser will trip after
this time).

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of phase delay curve protection setting

Overload（Overload）

Select Overload in relay menu, press “Enter” key to enter, operational processes as
shown below:

Step 1: Setting the overload protection current value, the
current value can be between 1A ~ 6000A.

Step 2: Setting the overload delay time, the delay time can
be between 0S ~ 99.99S.

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of overload protection setting
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Earth Fault (G.OC1)

Select G.OC1 in the relay menu press “Enter” key to enter, operational processes as
shown below:

Step 1: Choose the direction mode (0: No-direction earth
fault, 1: Directional earth fault).

Step 2: Setting the earth fault protection current value, the
current value can be between 1A ~ 6000A.

Step 3: Setting the earth fault delay time, the delay time
can be between 0S ~ 9.99S.

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of G.OC1 protection setting

Ground fast curve protection（G.OC2）

Select G.OC2 in relay menu, press “Enter” key to enter, operational processes as
shown below:

Step 1: Choose the operating mode (0: No-direction earth
fault, 1: Directional earth fault).

Step 2: Choose the Curve type of Inverse-time earth
overcurrent or definite time overcurrent (NONE).

Step 3: Setting the earth overcurrent protection current
value, the current value can be between 1A ~ 6000A.

Step 4: Setting the Time dial of time-overcurrent curve.

Step 5: Setting the Time adder of time-overcurrent curve
(the delay time to trip after “Tp”).

Step 6: Setting the Minimum response of time-overcurrent
curve (If the “Tp” less than it, the recloser will trip after
this time).

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of ground fast curve protection setting
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Ground delay curve protection（G.OC3）
Select G.OC3 in relay menu, press “Enter” key to enter, operational processes as
shown below:

Step 1: Choose the operating mode (0: No-direction earth
fault, 1: Directional earth fault).

Step 2: Choose the Curve type of Inverse-time earth
overcurrent or definite time overcurrent (NONE).

Step 3: Setting the earth overcurrent protection current
value, the current value can be between 1A ~ 6000A.

Step 4: Setting the Time dial of time-overcurrent curve.

Step 5: Setting the Time adder of time-overcurrent curve
(the delay time to trip after “Tp”).

Step 6: Setting the Minimum response of time-overcurrent
curve (If the “Tp” less than it, the recloser will trip after
this time).

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of ground delay curve protection setting

Sensitive earth fault

Select SEF in the relay menu press “Enter” key to enter, operational processes as
shown below:

Step 1: Choose the operating mode (0: No-direction earth
fault, 1: Directional earth fault).

Step 2: Setting the sensitive earth fault protection current
value, the current value can be between 1A ~ 80A.

Step 3: Setting the sensitive earth fault delay time, the
delay time can be between 0S ~ 9.99S.

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of SEF protection setting
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Cold Load (ColdLoad)

Select ColdLoad in the relay menu, press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the cold load protection phase current
value, the current value can be between 1A ~ 6000A.

Step 2: Setting the cold load protection ground current
value, the current value can be between 1A ~ 6000A.

Step 3: Setting the loss-load time, the time can be between
0.1S ~ 99.99S.

Step 4: Setting the restore time, the time can be between
0.1S ~ 99.99S.

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of cold load protection setting

Switch-Onto-Fault (SOTF)

Select SOTF in the relay menu, press “Enter” key to enter, operational processes as
shown below:

Step 1: Setting the SOTF exit time, the exit time can be
between 0.1S~9.99S.

Step 2: Setting the SOTF protection current value, the
current value can be between 1A ~ 6000A.

Step 3: Setting the delay time, the delay time can be
between 0S ~ 9.99S.

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of manual closing acceleration protection setting



62

Low-voltage protection (L.Under volt)

Select L.Under volt in the relay menu press “Enter” key to enter, operational
processes as shown below:

Step 1: Choose the operating mode (0: Invalid, 1: No
voltage + low voltage protection, 2: Via current lock low-
voltage protection, 3: Pure low voltage protection).

Step 2: Setting the protection voltage value, the voltage
value can be between 1KV ~ 42KV.

Step 3: Setting the delay time, the delay time can be
between 0S ~ 99.99S.

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of Under voltage protection setting

Note: This is L.Under volt protection setting, the use of the L.Under volt2 protection
is the same. The lockout current is in the common value.

Over Voltage (L.Over volt)

Select L.Over volt in the relay menu, press “Enter” key to enter, operational
processes as shown below:

Step 1: Choose the operating mode (0: Disable,1: Trip, 2:
Alarm).

Step 2: Setting the protection voltage value, the voltage
value can be between 1KV ~ 42KV.

Step 3: Setting the delay time, the delay time can be
between 0S ~ 99.99S.

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modify the corresponding value.

The operational processes of over voltage protection setting

Note: This is L.Over volt protection setting, the use of the L.Over volt2 protection is
the same.
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Frequency protection (Frequency)

Select Frequency in the relay menu, press “Enter” key to enter, operational
processes as shown below:

Step 1: Set the low frequency, the low frequency can be
between 40Hz~60Hz.

Step 2: Set the high frequency, the high frequency can be
between 50Hz~65Hz.

Step 3: Set the delay time, the delay time can be between
0.1S ~ 20S.

Step 4: Set the slip lock, the slip lock can be between 0 ~1
(0: disable 1: enable).

Step 5: Set the slip value, the slip value can be between
0.3 ~40.

Step 6: Set the low Voltage lock value, low Voltage lock
value can be between 0 ~1 (0: disable 1: enable).

Step 7: Set the low Voltage value, low Voltage value can be
between 1KV~42KV.

Note: Press [↓] key to switch to next screen, press the [+]
and [-] keys to modified value.

The operational processes of frequency protection setting

Direct.Power

Select Direct.Power in the relay menu, press “Enter” key to enter, operational
processes as shown below:

Step 1: Choose the operating mode (1: Trip, 2: Alarm).

Step 2: Set the protection power value, the power value
can be between 1KW ~ 60000KW.

Step 3: Set the delay time, the delay time can be between
0S ~ 60000S.

Step 4: Set the direction mode. None: overpower without
direction; Forward: forward direction overpower; Reverse:
reverse direction overpower.

Note: Press [↓] key to switch to next screen, press the
[+] and [-] keys to switch the mode, modified current
value and delayed time.

The operational processes of direct power protection setting
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PT breaking alarm (Common value)

Select Common value in the relay menu, press “Enter” key to enter, operational
processes as shown below:

Step 1: Choose the PT offline mode (0: Stop, 1: Lockout
voltage related components, 2: Unlock voltage related
components), press the [+] and [-] keys to switch the
mode.

Step 2: Setting the under voltage value, the under voltage
value can be between 1KV ~ 42KV.

Step 3: Setting the “U2 Lockout” value, the “U2 Lockout”
value can be between 1KV ~ 42KV.

Note: Press [↓] key to switch to next screen, press the
[+] and [-] keys to modify the corresponding value.

The operational processes of PT breaking alarming setting

Other common values (Common value)

Select Common value in the relay menu, press “Enter” key to enter, as shown
below:

The angle for judging the direction is set here. I0 start
angle and I0 end angle are used for ground current.

Note: Press [↓] key to switch to next screen, press the
[+] and [-] keys to modify the corresponding value.

The common value
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4.9 Save parameter

4.10 Parameter set

Press the EDIT → Para, enter the “parameter set”.

CT, VS and PTS rate set

CT rate is the measurement of three phase current. The
value of CT ratio is equal to the primary side current value
divided by the secondary side current value.

For e.g., 400/1 = 400 or 600/5 = 120.

VS ratio of the voltage sensor. The value of VS ratio is
equal to the primary side resistance value divided by the
secondary side resistance value.

The default secondary side resistance value is 0.036MΩ.

For e.g., 1. the primary side resistance value is 160MΩ,
160/0.036 = 4444; 2. the primary side resistance value is
500MΩ, 500/0.036 = 13888.

PTS rate is the measurement of power Voltage. The value
of PTS ratio is equal to the primary side Voltage value
divided by the secondary side Voltage value.

For e.g., 11000/110 = 100 or 24000/220 = 109.

Note:
1 Different current transformer, CT ratio becomes different.
2 Different Voltage sensor, VS ratio becomes different.
3 Different PT power Voltage transformer, PTS ratio becomes different.

Password set

After setting, press “ESC” key to exit, if modified below
figure will show. If you need to save press “Enter” key and
input password, otherwise press “ESC” key.

If you want to save, press the “Enter” key, and you need to
enter the correct password to save.

This interface appears, indicating that the saving is
successful.

If the password is error, this interface will appear.
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The device initial password is “0099”, the password for
the user to modify from the “0000” ~ “9999”, when
revised press “Enter” key to confirm, enter the password
before the modification.

Wear set

The rated number of mechanical trips is divided by the
total number of trips to obtain the mechanical wear ratio.

Target value of wear per phase.

Arcing time of circuit breaker.

Note: Please do not modify these values, if in doubt, please contact supplier.

Close and trip pulse time set

“Close pulse time” is the discharge time for close coil.

“Trip pulse time” is the discharge time for trip coil.

Note: Please do not modify the trip and close pulse time, if in doubt, please contact
supplier.
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4.11 Communication

Press the EDIT → Prot, enter to the communication set menu.

There are 2 communication channels in total here. Enter the
corresponding channels and set the corresponding settings.
The channel settings are as follows. There is also a common
setting.

Note: Press [↓] key to choose the port which you need to
set, press the[Enter] to Enter the menu, press [+] and [-]
keys to modified communication value.

Step 1: Enable this channel
0: Close this channel
1: Open this channel

Step 2: Set the baud rate of this channel (Default 9600).

Step 3: Select the communication protocol for this channel
1: IEC60870-5-101
2: IEC60870-5-104
3: DNP3.0
4: MODBUS

Step 4: Choose whether IEC60870-5-101 protocol is
balanced. 0: Unbalanced
1: Balance

Step 5: Set up device address or source address.

Step 6: Set up destination address (DNP3.0 needs to be set).

Step 7: Enable active upload (For 101 and 104 protocols).
0: Do not upload actively
1: Active upload

Step 8: Enable the active upload of signaling (For 101 and
104 protocols).

Step 9: How often is the signal uploaded.

Step 10: Enable the active upload of meter (For 101 and 104
protocols).

Step 11: How often is the meter uploaded.

Note: The settings of the three channels are the same.



68

Communication common settings are as follows:

Name Setting range Step length Description

Signal type 1～2 1 1: Single point
2: Double point

Control type 1～2 1 1: Single point
2: Double point

Meter type 1～4 1

1: Normalized telemetry
2: Normalized telemetry without
quality
3: Standardized telemetry
4: Short floating point telemetry

Address len 1～2 1 Address length
1: 1 byte 2: 2 byte

COT len 1～2 1 COT length
1: 1 byte 2: 2 byte

I factor 0.01～100 0.01 Phase current multiplier
I deadband 0.1～1000 0.1 Phase current dead zone
I0 factor 0.01～100 0.01 Zero sequence current multiplier
I0 deadband 0.1～1000 0.1 Zero sequence current dead zone
U factor 0.01～100 0.01 Line voltage multiplier
U deadband 0.1～1000 0.1 Line voltage dead zone
U0 factor 0.01～100 0.01 Zero sequence voltage multiplier
U0 deadband 0.1～1000 0.1 Zero sequence voltage dead zone
P factor 0.01～100 0.01 Power multiplier
P deadband 1～10000 1 Power dead zone
COS factor 0.01～100 0.01 COS multiplier
COS deadband 0.01～1 0.01 COS dead zone
OTH factor 0.01～100 0.01 Other multiplier
OTH deadband 0.01～1 0.01 Other dead zone
CLASSA 0～3 1 Class for analog event data
CLASSB 0～3 1 Class for digital event data
Select Timeout 0～30 0.1 Select/operate time-out

Confirm Link 0～1 1 Enable confirm data link (For 101
and 104 protocols)

Link Retry Times 0～15 1 Data link retries times
Link Timeout 0～50 0.1 Seconds to data link time-out

Upload Confirm 0～1 1 Enable upload confirmation (For
DNP3.0 protocols)

Upload Timeout 0～50 0.1 Seconds to upload time-out
Upload Retry Times 2～10 1 Upload retries times
Auto Refresh 0～1 1 Enable automatic reset of events
Refresh time 0～65535 1 Seconds to automatic reset event
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4.12 Calibration

Select the Edit submenu in “Chnl”, press “Enter” key to enter into the password
screen, enter the correct password to enter the “Chnl” submenu, press the [+] and
[-] keys to correct the value of current and voltage.

Note: All voltage and current values ​​in the factory have been corrected before.
Please do not change the parameter values ​​which, if in doubt, please contact
supplier.

4.13 Clear

Select the Edit submenu in “Clr.”, press “Enter” key to enter the “Clr.” Submenu.
The stored data can be cleared here. The contents include event records, counters,
wear.

Press “↑” and “↓” keys to switch, select the option to be cleared and press the “Enter”
key to enter the correct password.

4.14 Auto switch group

Press the EDIT → AGT, enter to the auto switch group set menu. Automatic
switchover can be set in this menu, which can be switched to summer workday
group, summer rest day group, winter workday group and winter rest day group.
You can also set the start and end time of summer and the start and end time of rest
days. Automatic group switching is based on time.

4.15 View relay and setting

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Relay” option to press “Enter” key to enter the “Relay” submenu, you can
view all the protection is enabled or disabled, select protection option press “Enter”
key to enter the value you can view each protection, press the arrow keys to switch
screens.
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4.16 View report

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select “RPT” option press “Enter” key to enter the “RPT” submenu, you can view the
recording events include: trip signal, alarm signals, SOE signal (circuit breaker status,
whether the manual or remote operation, fault trip, time and date, etc.), counters,
wear.

4.17 View input signal

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Input” option press “Enter” key to enter the “Input” submenu, you can
view the state of input signal.

The input signal includes: Breaker open, Breaker close, Remote open, Remote close,
Low pressure, Manual lock, Door, Active battery, Power fault, Spring ready, 2st
backup input. 0 to 1 represents binary input.
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Chapter 5: Peripheral Accessories

5.1 RF remote controller

Function of each key

A:Close

B:Trip

C:Unlock

D:Reset

Note:
1. In order to prevent misuse, press the unlock button for 3 seconds, before
execution of the closing operation.
2. The effective distance of RF remote controller is 30 meters.

5.2 Features and the use of external sockets and switches

AC power switch Backup switch Socket Activation button

Note: Before using the controller, ensure that the battery charge enough for 12
hours.

1. The AC power switch is for protecting the Auxiliary PT (Or utility incomer), and the
BACKUP switch is for charging batteries.
2. After charging the batteries, turn off the power switch to protect the batteries for
storage.
3. Activation button is not allowed for pressing last long time, or permanent damage
of battery under-voltage may result.
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5.3 The main secondary component parts

Cable plug, connect the controller
and circuit breakers

Surge protector

Note: For security norms, Surge protector has to be grounded (green line) to the
earth.

5.4 Capacitor (Used by permanent recloser)

1 Temperature range: -25°C~+105°C.

2 Rated voltage: DC250V.

3 Capacity: 33000Uf (-20~+20%).

4 Rated ripple current: 34.7Arms.

Note: The following operation will cause self-heating of the capacitor that can result
in leaking electrolyte outside the seal area. worst of all, perhaps there will be burst
or spark that can lead the capacitor to spontaneous combustion.

1. Inverse voltage.

2. Overvoltage (over rated voltage).

3. Exceeding the rated ripple current.

4. Violently charge/discharge.

5.5 Battery

 RWK-351 stand-by battery adopts two 7AH lead-acid free of maintenance
batteries, the average battery life exceeds 3 years.

 Please replace the storage battery in time when the storage battery exceeds its
usage life. Replace method as following: firstly push the stand-by power supply
switch to trip position, and pull out the connection cable simultaneously, rotate
the support bolt away, replace the used battery with new battery. Then recover
the device to the original status according to the contrary sequence. Please deal
with the used battery properly in order not to pollute the environment.
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Chapter 6: Installation and Maintenance

Danger: The dangerous voltage with the device maybe result in the permanent
damage of equipment or personnel casualty during installing RWK-381. These
voltages mainly distributes at terminal bar of device and circuits of AC current input,
AC voltage input, digital input, IGBT output and operation power supply., etc. This
device’s installation, debugging and maintenance can only be operated by technical
staff who has been authorized and trained strictly.

6.1 Installation

☆ See the Quick Reference Guide for details！

6.2 Maintenance

 If the device is not used, it should be kept in dry and ventilated places indoors,
and charged once every three months, the charging time should be more than
24 hours. Before the device is used, the charging time should not be less than
24 hours. Replace the storage battery each three years.

 This device has storage battery management module, which will automatically
cut off the storage battery output circuit when the storage battery voltage is on
the low side. You should check the storage battery each year, please replace the
storage battery immediately when single storage battery voltage id lower than
DC12V.

 Please firstly make sure the first system is power off before the device is
maintained, forbid inserting or pulling out aeronautical connector under power,
thus avoid CT short circuit happening.

6.3 Parts Attached with the Device

Name Quantity Collocation Usage or Description

Box door key 1 Standard Open the box

User Manual 1 Standard
Please read it carefully before
use the device, controller wiring

diagram is attached.

Hand-held
telecontroller 1 Selectable Telecontrol the close and trip of

switch within 30 meters

CD 1 Standard Testing debugging software

Communication
Interface 1 Selectable RS485/USB converter or

RS485/RS232 converter

Control Cable 1 Standard 20 cords (6 meters)

Power Cable 1 Selectable 2 cords power cable (6 meters)
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Chapter 7: Decommission and Disposal

7.1 Decommission

Shut-down Power Supply

Shut-down Device Power Supply: Turn off external power supply switch of the device.

Disconnect All Power Cables

Disconnect all power cables connected to the device.

Danger: Before disconnecting all power cables connected to the device power
module, it must confirm that the external power switch is turned off to avoid danger.

Danger: Disconnecting all power cables connected to the device alternating current
module, it must confirm that the equipment corresponding to input alternating
component has stopped operation to avoid danger.

Dismantle from Display Cabinet

When the above steps are completed, loosen the fix screws and dismantle the device
from the display cabinet.

Danger: When neighboring equipment is in operation, it must strictly confirm the
safety distance between the dismantled device and other device in operation and
unskilled professional shall take particular caution.

7.2 Disposal

When dispose decommissioned device, please follow relevant regulations of the
country where the product is used for the disposal of scrapped electronic products.

Caution: It must strictly adhere to relevant regulations of the country where the
product is used for the disposal of scrapped electronic products.
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